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What is the status of my submission?

Consult this table for more information about each submission state (status) your manuscript can be in.
For further details, contact the journal's editorial office.
To find the journal editorial contact information in Research Exchange Submission, do the following:

1. Go to the My Submissions page.
2. Locate the submission you wish to inquire about and click Submission overview.

My Submissions

Lavoisier's Head
Research Article

Phlogiston and the Joy of Theoretical Chemistry

Submission Status Submitted
Submitted On 20 August 2024 by Marie Curie

Submission Started 20 August 2024 by Marie Curie

3. On the next page, click EDITORIAL CONTACT.

Lavoisier's Head

AUTHOR GUIDELINES EDITORIAL CONTACT

O

Submission Overview

4. You will be redirected to the journal's contact page or the journal's contact email will be displayed.

This submission has b
editorial office and car
Further information w
you by the journal edit

Submission ove




| Log in and Manage Your Account | 5

Log in and Manage Your Account

Note: The platform you're currently on may differ in how its login and profile management system works.

To log in, navigate to https://{publisher code}.atyponrex.com.

Research Exchange Submission uses the CONNECT login system.

Sign up to CONNECT (support.scienceconnect.io)

Edit your personal information (support.scienceconnect.io)

Edit your account settings and permissions (support.scienceconnect.io)
Delete your account (support.scienceconnect.io)

View and edit your sign in details (support.scienceconnect.io)

Manage your password (support.scienceconnect.io)

Manage Your Profile

Note: The platform you're currently on may differ in how its login and profile management system works.

1. Click your name in the upper right.
2. Click My Profile.

You will be redirected to your CONNECT profile page.

Refer to the CONNECT help pages for more information about managing your profile.

Note: Adding your ORCID iD to your CONNECT profile also adds it to your Research Exchange
Submission account and vice versa. If the ORCID iD is already in use by another Research Exchange


https://support.scienceconnect.io/about/c_con_ab_sign-up.html
https://support.scienceconnect.io/profile/c_con_pro_my-profile.html#t_con_pro_edit-personal-info
https://support.scienceconnect.io/profile/c_con_pro_my-profile.html#t_con_account_edit-account-settings
https://support.scienceconnect.io/profile/c_con_pro_my-profile.html#delete_your_account
https://support.scienceconnect.io/sign-in/t_con_sign_view-edit-sign-in-details.html#t_con_sign_view-edit-sign-in-details
https://support.scienceconnect.io/sign-in/c_con_sign_manage-your-password.html#c_con_sign_manage-your-password
https://support.scienceconnect.io/
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Submission account, CONNECT will prompt you to choose which account should use the ORCID iD.

C CONNECT

0000-0001-1234-5678

This ORCID ID is already linked with another profile. Please

confirm to move it to your current profile.

Curie, Marie
mecurie@parisuniversity.com

Marie Curie Current profile
mcurie@example.com

| acknowledge that this action will remove this ORCID
1D from the profile it is linked with and move it to my

current profile.

Cancel

Use the My Submissions Page

1. Click My Submissions.
By default, all your submissions are displayed.

2. Optionally filter your submissions by Publication, Submission Status, or Author Role.

Submission States (Statuses)
Submissions can have one of the states described in the table below.

For more information about any of these states, contact the journal's editorial office.

State Description

Accepted The submission process has completed with an Accept
decision.

Accepted (Final Files) Note: Not applicable on all platforms.

The submission process has completed with an Accept
decision.

Accepted, Pending Agreement Note: Not applicable on all platforms.
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State

Description

Your conference submission has been accepted, but you
need to complete the publication agreement.

Accepted, Under Review for Production

Note: Not applicable on all platforms.

The manuscript has been accepted, but additional
updates may be requested.

Accepted, Updates Requested

Note: Not applicable on all platforms.

The manuscript has been accepted, but additional
updates are required before it can be published.

Draft You have not yet submitted the manuscript.
Draft Invited A draft invited submission
Draft (Transferred) Note: Not applicable on all platforms.

You have not yet submitted the manuscript.

In Revision

The Editor has made a decision and requested that you
revise the submission.

In Screening

Note: Not applicable on all platforms.

The submission is in screening.

Rejected

The submission process has completed with a Reject
decision.

Replaced

The submission has been resubmitted as new by a
Research Exchange Submission admin and replaced by
a newer submission. The submission card includes a link
at the top to the submission that replaced it.

Submitted

You have completed the submission steps, and the
manuscript has been submitted to the journal. Once
a manuscript is successfully submitted, a unique
manuscript number is assigned automatically by the
system. Normally, the corresponding author will be
notified of the manuscript number via email.

Under Review

The peer review process is underway. There are several
factors that influence the time taken for review, most
notably availability of article referees. Peer review times
vary per manuscript.

Withdrawn

You have withdrawn the manuscript for consideration, or
an Editor has done so on your behalf.

Manage Your ORCID iD

Note: The platform you're currently on may differ in how its login and profile management system works.

You can connect or unlink your ORCID iD to your Research Exchange Submission account in several ways:

* On most platforms, when logging in to Research Exchange Submission.

» Ifyou are the co-author of a manuscript you did not submit and receive an email invitation to connect your

ORCID iD.
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*  From the My ORCID iD page.

* During submission or revision, in the Author Details submission step, if you are submitting to a journal that
collects author ORCID information.

Note: You can connect your ORCID iD in the Author Details submission step only if you are one of the authors
of the manuscript.

The important things to know are that:

* Research Exchange Submission accounts are powered by the CONNECT login system.

*  Your ORCID iD is associated with your Research Exchange Submission / CONNECT account overall, and not,
for example, a single submission.

*  You can connect your ORCID iD with a single Research Exchange Submission / CONNECT account at a time.

* Connecting or unlinking your ORCID iD to or from your Research Exchange Submission account means that you
are also doing this for your CONNECT account. So if you use CONNECT with multiple publishers' submission
systems, your ORCID iD will be added to or removed from those systems as well.
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1. To connect your ORCID iD, do the following:
Navigate to the area in Research Exchange Submission where you can begin the process.
The required steps differ depending on the area:

*  On the login screen, click ORCID.

» Ifyou received an invitation email, click Connect your ORCID iD in the email and then, in Research
Exchange Submission, on the Submission Overview page, click Connect ORCID iD, and then, on the My
ORCID iD page, Create or connect your ORCID iD.

* To do so from the My ORCID iD page, click your name in the upper right, and then My ORCID iD.

My Submissions Marie v o

My Profile

ubmission Stat My ORCID iD 9

All Submissio Help

i

Logout

Then click Create or connect your ORCID iD.

My ORCID iD

Journals often encourage authors to connect their ORCID iD to their submissions to ensure they get ¢

Connect your ORCID iD

Create or connect your Ol
Linking your ORCID iD connects your published

research to your ORCID record.

Learn more about why Example Publishing collects
ORCID iDs and what happens when you connect
yours.

* During submission or revision, if the journal collects author ORCID information from submitting authors, the
Author Details submission step will include a Connect your ORCID iD section. In this section, click Create
or connect your ORCID iD.

You will be redirected to an ORCID login page, where you can enter your ORCID credentials or create a new
ORCID iD.

If your ORCID iD is already connected with another Research Exchange Submission / CONNECT account, you
will be prompted to choose which account it should be connected with moving forward.
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C CONNECT

0000-0001-1234-5678

This ORCID ID is already linked with another profile. Please

confirm to move it to your current profile.

Curie, Marie
mecurie@parisuniversity.com

Marie Curie Current profile
mcurie@example.com

| acknowledge that this action will remove this ORCID
ID from the profile it is linked with and move it to my

current profile.

Cancel

Important: As explained above, your choice here impacts any accounts you have on other publishers' systems.

Once you have successfully entered your ORCID credentials, you will be redirected back to the Research
Exchange Submission page you were previously viewing, or trying to get to:

» Ifyou were logging in to Research Exchange Submission, you will be redirected to the My Submissions page.

» If you started the process by clicking a link in an email invitation, you will be redirected to the My ORCID iD
page.

* Ifyouused the My ORCID iD page, you will be redirected back to that page.

» Ifyou clicked a link in the Author Details submission step, you will return to that step.

2. To unlink your ORCID iD, do one of the following:

*  From the My ORCID iD page, click your name in the upper right, then My ORCID iD, then Unlink.
* From the Author Details submission step, click Connect your ORCID iD > Unlink.

View a Submission You Co-authored

Depending on how a journal is configured, you may be able to view submissions you co-authored, but did not submit,
on Research Exchange Submission.

In such cases, when the manuscript is submitted, you will receive one of two email notifications:

» If the journal does not collect ORCID iDs for co-authors, you will receive a notification with the subject, Action
Recommended: View your submission to {journal title},where {journal title} isthe
title of the journal.
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+ If the journal does collect ORCID iDs for co-authors, you will receive a notification with the subject, Action
Recommended: Connect your ORCID iD to your submission {manuscript ID}, where
{manuscript ID} is the submission's ScholarOne manuscript ID.

If you receive an email invitation to connect your ORCID iD, follow these steps.
For the first case, follow the instructions below.

1. In the email you received, click View submission.

Hi Pierre Curie,

You are listed as a co-author of a submission to Lavoisiers Head. You can now view the
submission and check the status of submissions you have authored / co-authored.

Submission Details

Submission title: Phlogiston and the Joy of Theoretical Chemistry
Manuscript ID: EGP-2023-08-0035

Journal: Lavoisier's Head

The submitting author is solely responsible for communicating with the journal and managing
communication between co-authors. Please contact the submitting author directly with any queries
you may have related to this submission.

You will be asked to log in to or register for Example Publishing's Research Exchange to
use this service.

View submission

Mote: This link is unique to you. Please don't forward or share with others.

Need help?

« For support with your account or Research Exchange submission, contact

« If you believe you have received this email in error, contact

You will be directed to the Research Exchange Submission website.
2. Log in to the Research Exchange Submission site.

a) If you do not already have an account for Research Exchange Submission, you will have to create an account
before you can log in.

b) If you already have an account for Research Exchange Submission but it is associated with a different email
address than the one listed for you in the manuscript, then Research Exchange Submission will prompt you to
verify your email address before you can log in.

The email address in the manuscript will not change. The submission will be associated with your existing
Research Exchange Submission account with the different email address.
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3. Once you have logged in, you will be directed to the Submission Overview page for the submission you co-
authored.

Submission Overview

Initial Submission This submission has been sent to the editorial office
and cannort be edited

Article Type Research Article

Title Phlogiston and the Joy of Theoretical Chemistry

The submission will also be included on your My Submissions page.

Note: As a co-author, you may find that you cannot view older submissions that you co-authored for a specific
journal from the My Submissions page. This is because the option to view co-authored submissions from this
page applies only to submissions that are made after the date a journal makes this option available.

If any of the information in the submission is incorrect, contact the submitting author. Note that if the submission
is immediately accepted, there will not be a chance for the submitting author to make any updates. Alternatively,
information can be updated prior to submitting a revision or resubmission.

Start a New Submission

1. Choose the journal you want to submit to.

2. Prepare your manuscript according to the journal's guidelines.

3. Click the Submit or similarly labeled link on the journal website.
If you know the journal code, you can navigate directly to the journal's Research Exchange Submission
submission page.

For example, if the journal Lavoisier's Head has the journal code LVH, then, to navigate to the journal's Research
Exchange Submission submission page, use either of the following URLs:

* https://{publisher code}.atyponrex.com/journal/lvh

* https://{publisher code}.atyponrex.com/submission/dashboard?
journalCode=1vh

4. Log in to Research Exchange Submission.
5. Click Start submission.
6. Click Your Progress > Article Type.

Complete the submission steps, beginning with the Article Type step.

Article Type

1. Select your manuscript's article type from the What kind of manuscript are you submitting? > Article Type
dropdown.
If this is not an initial submission and the article type you selected during initial submission is no longer available,
follow these steps.
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2. Ifthe journal allows authors to select their preferred peer review method, then in the Select your preferred type
of peer review section select Single anonymized or Double anonymized.

If you had previously completed this step and selected Single anonymized and also uploaded your manuscript
file(s) in the Upload Manuscript step, and are now revisiting this step and select Double anonymized, Research
Exchange Submission will prompt you if you want to delete your manuscript file. This is because you need to
reupload your manuscript file(s) so that they do not include any author-identifying information. You will upload
author-identifying information separately, in a title page file, which will be a required file.

3. Check all the boxes for the submission requirement questions.
4. Click Confirm.
If you cannot proceed to the next submission step after clicking Confirm, follow these steps.

You will be redirected to the Progress Board page for this submission. A check mark will be displayed next to the
Article Type submission step, indicating that it is complete.

Continue with the next submission step, Upload Manuscript.

Cannot Select Same Article Type as Initial Submission

You are submitting a returned (unsubmitted) manuscript, and the article type you selected during your initial
submission is no longer available from the What kind of manuscript are you submitting? > Article Type
dropdown.

Why it happens
The journal no longer supports that article type.

To resolve
1. Do not select any value from the dropdown.

Important: If you select a different article type from the dropdown, you will not be able to later select the
original article type.

By not selecting a value from the dropdown, the article type from your initial submission will be retained for your
new submission.

2. Continue the submission process and answer the submission requirements questions.

Cannot Proceed Past Article Type Step

When you click Confirm during the Article Type step, you cannot proceed to next submission step.

No Article Type Selected

You have not selected an article type.
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What kind of manuscript are you I
submitting?

Article Type

This journal requires that you confirm
all items above in order to proceed.

Confirm A

Please correct items above to continue
or consider a different journal

Unanswered Submission Requirements Questions

You have not checked all the boxes for the submission requirements questions.

D | confirm that all authors of this submission have understood the l
journal's licensing policy. Further information about the journal's
license agreement(s) and Terms of Use can be found in the journal's
Author Guidelines.

This journal requires that you confirm
all items above in order to proceed.

Confirm A

Please correct items above to continue

or consider a different journal

To resolve

1. Ensure you have selected an article type from the dropdown.
2. Check all the boxes for the submission requirements questions.

a) Alternatively, click a different journal to view other journals by the publisher.
3. Continue the submission and click Confirm.

Upload Manuscript

File names of files uploaded to Research Exchange Submission should not be longer than 256 characters.

The combined size limit of all files uploaded to Research Exchange Submission is 500 MB.
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If you encounter an error during file upload, including the A virus has been found: Remove or replace this file on
page 23 error, delete the uploaded file, and upload a version of the file that is virus-free and within the file name
length limit.

Note: While there is not an explicit size limit for each file, in such cases, try to upload versions of the files where
each file is under 25 MB.

For submissions that will be reviewed using double-anonymized peer review, make sure to not include any author-
identifying information in your main manuscript(s) files.

If you are not sure which peer review type will be used for a submission, check if Title Page is included under
Upload Manuscript > Required Files. If a title page is required and the description is similar to the following, the
submission will be reviewed using double-anonymized peer review:

The Title Page will not be sent to peer reviewers and should include
your manuscript title, authors' names and affiliations, address for
correspondence including email address, acknowledgements, and conflict
of interest statement.

1. Ifthe journal only accepts main manuscript documents in DOC or DOCX format, click Upload and select your
main manuscript document.

2. Alternatively, if the journal also accepts main manuscript document in LaTeX format, click Add Files and do the
following:
a) Select the main manuscript type, Main Document - MS Word or Main Document - LaTeX.
b) Click Add Files.

1. If you are submitting a manuscript in DOC or DOCX format, click Upload and upload your main
manuscript document.
2. If you are submitting a manuscript in LaTeX format, follow these steps.
c¢) Click Confirm.
Important: The manuscript type you select during initial submission persists during revision. For example, if
your initial submission is in DOC or DOCX format, you cannot submit a LaTeX main document during revision.
3. Optionally, if you need to delete the manuscript file(s), click the delete icon.

4. If you are submitting a revision and do not need to upload a new version of your manuscript, check the I have not
made any updates to my main document box.
Research Exchange Submission will display information about the manuscript file(s) you uploaded during your
initial submission below the checkbox.

5. If you are submitting a revision, upload a file with your author response to the decision letter in DOC, DOCX,
PDF, RTF, or TXT format.

6. If the submission will be reviewed using double-anonymized peer review, click Title Page > Upload, and upload
a title page in DOC or DOCX format.

Include the following information in the title page file:

+ Title
* Author name(s)
* Author email address(es)
* Author affiliation(s)
The information listed above are the items that Research Exchange Submission can automatically extract from the
title page file. However, the journal to which you are submitting may require you to include additional information
in the title page file. Make sure to follow the journal's submission guidelines.
Do not include any author-identifying information in the manuscript's main document file.
7. Provide any conflict of interest (COI) information for the manuscript.

a) Ifnone of the authors have a conflict of interest to disclose, check the None of the authors have a conflict of
interest to disclose box.

b) Alternatively, upload a single conflict of interest statement in PDF, RTF, DOC, or DOCX format.
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8. Optionally, upload any additional manuscript files, such as figures or tables.
The journal may require that you provide a label and/or description for certain files, such as figures.
9. Click Confirm.

You will be redirected back to the Progress Board page for the submission. Under Your Progress, the next step you
need to take will be highlighted.

If you are submitting an initial submission, resubmitting a rejected manuscript, or resuming submission for a returned
(unsubmitted) manuscript, click Title.

If you are submitting a revision, click the step that is highlighted under Your Progress. If no other steps require your

attention, this will be the Final Review step.

Upload a LaTeX Main Manuscript

Ensure that you have done the following on the Upload Manuscript step:

1. Clicked Required Files > Main Manuscript > Add Files.
2. Selected Main Document - LaTeX.
3. Clicked Add Files.

Note: When submitting the main document in LaTeX format, you must also submit a LaTeX PDF.
1. Click Main Document - LaTeX > Upload and upload one of the following:

* Asingle . tex file.
* A .zipor.tar.gz archive that contains multiple . tex files.

Select Main Manuscript Type Add Files X

Main Document - LaTeX

% Upload

A Required
v

You may submit your manuscript
Main Document in LaTeX format, but
you must also provide a separate PDF
output of your LaTeX file.

Main Document - LaTeX

AT load
PDF P

A Required v pdf

A LaTeX PDF is required if you provide

a .tex Main Document.

2. Click Main Document - LaTeX PDF > Upload and upload a single, compiled PDF output file generated from
your LaTeX main document file(s).
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3. Ifyouuploadeda .zip or . tar.gz archive that contains multiple . tex files, do the following:
a) Click Select Main File.

b)

Select Main Manuscript Add Select Main X
Type Files File

Phlogiston and the Joy of Theoretical

; : ® @
Chemistry.zip
Type of File Main Document - LaTeX
Size 2.4 KB
Phlogiston and the Joy of Theoretical o 8§
L2

Chemistry.pdf

Type of File Main Document - LaTeX PDF
Size 153.6 KB

€ Back Select Main File -2

Select which . tex file is the main file.

Select Main Manuscript Add Select Main %

Type Files File

Select the main manuscript file from the list of .tex files we found
in your LaTeX package.

(@ Main.tex

O Methods.tex

Can't find your main file? Double-check the package you provided
and try again. If you have checked your file and are still
encountering this issue, contact customer support for assistance.
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¢) Click Confirm.
Once you have confirmed the main file, the popover window will close, and you will return to the Upload
Manuscript screen.

If you encounter the No .tex files found error, follow these steps.
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4. Optionally, if you need to delete the LaTeX and/or PDF files after uploading them, do one of the following:

a) Click the delete icon next to respective file name in the Select Main Manuscript Type > Add Files tab.

b)

Select Main Manuscript Add
Type Files

Phlogiston and the Joy of Theoretical

Select Main
File

Chemistry.tar.gz

Type of File Main Document - LaTeX
Size 1098B

Phlogiston and the Joy of Theoretical

@

Chemistry.pdf

Type of File ~ Main Document - LaTeX PDF
Size 153.6 KB

X

K

® @

€ Back Select Main File =

Your Main Manuscript document may be

should not include any supplementary
materials.

You may bundle LaTeX manuscript files in a
single archive including all LaTeX files, BibTeX
files, figures, tables, all LaTeX classes and
packages, and any other material that belongs
o your main manuscript

Phlogiston and the Joy of Main Document -
Theoretical Chemistry.pdf LaTeX PDF

Name Type of File Size
Phlogiston and the Joy of Main Document - 109 B
Theoretical Chemistry.tar.gz  LaTeX 4

153.6 KB

submitted without journal-specific reformatting. + Add Files
It may include embedded figures and tables, but

&

In this case both the LaTeX and PDF files will be deleted.

Click the delete icon in the Upload Manuscript > Required Files > Main Manuscript section.
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Continue with the Upload Manuscript step:

+ Ifyou are submitting a revision, provide your author response.

» If you are submitting a new manuscript, provide your conflict of interest information.
No .tex files found

If Research Exchange Submission cannot locate . tex files in the uploaded . zip or . tar.gz archive, it will
display the No .tex files found message on the Select Main Manuscript Type > Add Files > Select Main
File tab.

Select Main Manuscript Add Select Main X
Type Files File

A No .tex files found

We could not find a .tex file in the manuscript package you
provided. Double-check the package you provided and try again.

Need help? Here are some common reasons a .tex file may not be
found:

* No files with a .tex extension in the package

¢ Main package is password protected

e Main .tex file sits inside of a nested package (e.g. zip file
inside of a zip file)

If you have checked your file and are still encountering this issue,
contact customer support for assistance.

&« Back Confirm A

Why it happens

The error message displays some common causes for the error, which include:
* The archive you uploaded did not include any TEX files.

» The archive you uploaded is password-protected.

* The main TEX file is not included at the root level of the archive. For example, you uploaded a ZIP archive that
contains another ZIP archive, and the main TEX file is included inside the second, nested, archive.

To resolve

1. Click Back to return to the Add Files stage.
2. From Add Files delete the . zip or . tar.gz archive.

3. Ensure that the contents of archive are according to the required structure, for example, that the main TEX file is
at the top level of the archive.

=

Upload the corrected version of the archive.
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Which file types does Research Exchange Submission support?

The supported file formats for the main document depend on each journal's requirements. A journal will accept one or
more of the following formats:

* A Microsoft Word .docx document.

* Asingle LaTeX .tex file.

* A ZIP or .tar.gz archive containing multiple LaTeX files, as well as BibTeX files, figures, tables, all LaTeX classes
and packages, and any other material that belongs to your main manuscript.

* A PDF file.

Note: When uploading your main document in LaTeX format, either as a single .tex file or as a .zip or .tar.gz archive
containing multiple .tex files, then you are required to upload a single, compiled PDF output file generated from your
LaTeX main document file(s).

WordArt or other unusual formatting in the main document may cause errors with the document import. Try
converting WordArt to plain text, or an image, as appropriate, and removing any unusual formatting, then save your
document and try again.

For all document types, Research Exchange Submission does not support executable or script file formats such as
EXE, BAT, JS, or VBS.

Document types that accept only certain file formats are listed below. Document types that are not listed below accept
most file formats.

Note: If a journal specifies that you should not upload certain file types, then follow the journal's guidelines even if
Research Exchange Submission permits you to upload such files.

Document Type Supported File Types
Embedded Video + MP4

« M4V

« WMV

« MPG

+ MPEG

+ AVI

« MOV
Embedded Audio « MP3

« M4A

+ M4P

+ WMA

« WAV

+ OGG

+ FLAC
Transcription « DOC

« DOCX

o TXT

+ RTF

 PDF
Author Response « DOC

+ DOCX

+ PDF

* RTF
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Document Type Supported File Types
o TXT
Supplementary Zip Bundle « 7ZIP
README file « DOC
Note: Not available on all platforms. + DOCX
« PDF
+ RTF
« TXT

Reorder Files

If you upload multiple files of the same file designation, for example, multiple figures, by default Research Exchange
Submission lists the files in alphabetical order. However, if you want the files to be displayed in a different order than
the default one, you can drag and drop the files to reorder them.

The Reordering allowed label is displayed for file designations that support file reordering.

Note: For file designations with companion files, children files cannot be reordered separately from their parent files.

Files cannot be moved from one designation to another, for example, from Figures to Tables.

1. Click the reordering icon to the left of the file name, and then drag and drop the file.

Figure
% Optional
v Mostimage files

Reordering allowed

You may provide figures separately if
they aren't embedded in your Main
Document.

Accepted file types: Most image files

. figurel.png

Size 1.3KB

ﬁ figure2.png
we 11

Size 1.4 KB

% Upload
Delete all
0 i
© @

The order of files will be altered. In the example below, the order of figurel.png and figure2.png has

been changed:

Figure

% Optional
¥ Mostimage files

#  Reordering allowed

You may provide figures separately if
they aren't embedded in your Main
Document.

Accepted file types: Most image files

figure2.png

Size 1.4 KB

figurel.png
Size 1.3KB

& Upload
Delete all
@ [i]
@ [i]



2. When you have completed the Upload Manuscript submission step, click Confirm.

Research Exchange Submission will display the files to reviewers in the order you specified.

We cannot accept file names larger than 256 bytes

MName

ejpg

Upload failed

We cannot accept file names larger
than 256 bytes

figurefigurefigurefigurefig 305
urefigurefigurefigurefigur

Please rename affected file(s) and
upload again

Bytes

Why it happens
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Research Exchange Submission does not support file names that are longer than 256 characters (bytes).

To resolve
1. Click Dismiss.

2. Rename the file so the name is shorter than 256 characters.

3. Upload the renamed file to Research Exchange Submission.

A virus has been found: Remove or replace this file

Required Files

Upload Manuscript

The files initially shown on this page are the files you sent on initial Submission, Be sure to review the decision letter and then follow the directions an each step below.

Main Manuscript

A Required
~ M5 Word

Maximum of 1 Main
Manuscript

@

Your Main Manuscript document may be submitted without journal-specific refarmatting. It may
include embedded figures and tables, but should not include any supplementary materials + Add Files
|:| 1 have not made any updates o my main detument

& There was a problem reading your docx, Please check the file

Name Type of File Size Last Modified

dock  Main Document - MS Word 800.7 KE Revision 1
rd
A Avirus has been found: Remove or replace this file

docx  Main Document - Tracked Changes 9893 KB Rewision 1

A Avirus has been found: Remove or replace this file




| Start a New Submission | 24

Why it happens

The file is either infected with a virus or, in some cases, is too large.

To resolve

1. Delete the files that Research Exchange Submission has identified as being infected with a virus.
2. Upload new versions of the files that you have scanned and know to be virus-free.
Ensure that each file is less than 25 MB in size.

If Research Exchange Submission continues to identify DOCX files as being infected, try uploading versions of
the files in DOC format. If that also does not resolve the issue, contact Research Exchange Submission support.

Title

Research Exchange Submission will attempt to automatically extract your manuscript's title from the manuscript main
document.

1. If the automatic title selection is correct, click Yes, this is my title.

2. Alternatively, if the automatic title selection is not correct, click No, let me select it.
The Detailed instructions window opens. It displays an animated image showing how you can select your title.
a) Highlight the title of the manuscript.

If the title selection is not correct, click Something is wrong with my title and follow these steps. Alternatively, if
you encounter the Title exceeds journal's limit error, follow these steps.

3. Click Confirm title.

You will be redirected to the next submission step, Abstract.

Something is wrong with my Title

Your manuscript title has not been correctly selected.

Why it happens

Research Exchange Submission is unable to correctly parse your main manuscript document, either due to special
formatting in the document such as word art, or for some other reason.

To resolve

1. Click Option 1: Edit and re-upload Main Document > Back to Upload Manuscript.
You will be redirected to the Upload Manuscript submission step, where you can delete your main manuscript
document and upload a new one.
2. Alternatively, do the following:
a) In the Option 2: Provide Title manually > Title field, enter the correct title.
b) Click Confirm Title.
You will be redirected to the Abstract submission step, from where you can continue your submission.
3. Or, if you want to try again to select your title from the manuscript, click Nevermind, I'll select the Title from

my Manuscript.
You will be redirected to the Title submission step.
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Title exceeds journal's limit

Title exceeds
journal’s limit

Your current selection
uses 259 of 100
characters allowed

Upload an updated

manuscript

Let me reselect it

Why it happens

The journal imposes a limit on the manuscript title length, and your title exceeds it.

To resolve
1. Click Upload an updated manuscript to go back to the Upload Manuscript step, delete the main manuscript
document(s), and upload a new version with a title that is inside the limit specified by the error message.

2. Alternatively, click Let me reselect it to continue in the Title submission step and select a shorter segment of the
title.
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3. If the warning message is displayed during initial submission and the Continue anyway option is available, you
can click it to proceed to the next submission step without altering the title, but you will need to update the title to
a shorter one during revision.

Title exceeds
journal’s limit

Your current selection
uses 409 of 100
characters allowed

You may continue anyway and fix it
during revision

Upload an updated

manuscript

Continue anyway

Let me reselect it

Abstract

Research Exchange Submission will attempt to automatically extract your manuscript's abstract from the manuscript
main document.

1. If the automatic abstract selection is correct, click Yes, this is my abstract.
2. Alternatively, if the automatic abstract selection is not correct, click No, let me select it.

The Detailed instructions window opens. It displays an animated image showing how you can select your
abstract.

a) Highlight the abstract of the manuscript.

If the abstract selection is not correct, click Something is wrong with my abstract and follow these steps.
Alternatively, if you encounter the Abstract exceeds journal's limit error, follow these steps.

3. Click Confirm abstract.

You will be redirected to the next submission step, Authors.

Something is wrong with my Abstract

Your manuscript abstract has not been correctly selected.
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Why it happens

Research Exchange Submission is unable to correctly parse your main manuscript document, either due to special
formatting in the document such as word art, or for some other reason.

To resolve

1. Click Option 1: Edit and re-upload Main Document > Back to Upload Manuscript.
You will be redirected to the Upload Manuscript submission step, where you can delete your main manuscript
document and upload a new one.
2. Alternatively, do the following:
a) Inthe Option 2: Provide Abstract manually > Abstract field, enter the correct title.
b) Click Confirm Abstract.
You will be redirected to the Authors submission step, from where you can continue your submission.

3. Or, if you want to try again to select your title from the manuscript, click Nevermind, I'll select the Abstract
from my Manuscript.
You will be redirected to the Abstract submission step.

Abstract exceeds journal's limit

Abstract exceeds
journal’s limit

Your current selection
uses 295 of 100
characters allowed

Upload an updated

manuscript

Let me reselect it

Why it happens

The journal imposes a limit on the manuscript abstract length, and your abstract exceeds it.

To resolve
1. Click Upload an updated manuscript to go back to the Upload Manuscript step, delete the main manuscript
document(s), and upload a new version with an abstract that is inside the limit specified by the error message.

2. Alternatively, click Let me reselect it to continue in the Abstract submission step and select a shorter segment of
the abstract.
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3. If the warning message is displayed during initial submission and the Continue anyway option is available, you
can click it to proceed to the next submission step without altering the abstract, but you will need to update the
abstract to a shorter one during revision.

Abstract exceeds
journal’s limit

Your current selection
uses 295 of 100
characters allowed

You may continue anyway and fix it
during revision

Upload an updated

manuscript

Continue anyway

Let me reselect it

Authors

Research Exchange Submission will attempt to automatically extract your manuscript's author names from the
manuscript main document.

1. If the automatic author name selection is correct, click Yes, all author(s) are corect.
2. Alternatively, if the automatic author name selection is not correct, click No, let me fix them.

a) Click and drag to highlight each author name in the manuscript.

If the author name selection is not correct, click Something is wrong with my authors and follow these steps.
3. Click Confirm author(s).

If you encounter the Something went wrong error, follow these steps.

You will be redirected to the next submission step, Affiliations.

Something is wrong with my Authors

The author names in your manuscript have not been correctly selected.

Why it happens

Research Exchange Submission is unable to correctly parse your main manuscript document, either due to special
formatting in the document such as word art, or for some other reason.
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To resolve

1. Click Option 1: Edit and re-upload Main Document > Back to Upload Manuscript.
You will be redirected to the Upload Manuscript submission step, where you can delete your main manuscript
document and upload a new one.

2. Alternatively, click Option 2: Provide Authors manually in a later step > Provide Authors later.
You will be redirected to the next submission step, Affiliations. You can enter the author names in a later step,
Author Details.

3. Or, if you want to try again to select the author names from your manuscript, click Nevermind, I'll select the
Authors from my Manuscript.
You will be redirected to the Authors submission step.

Affiliations

Research Exchange Submission will attempt to automatically extract the authors' affiliations from the manuscript
main document.

When selecting or confirming affiliations, ensure that each affiliation includes the complete organization or institution
address. At a minimum, ensure the affiliation includes the institution name and country, but a complete affiliation also
includes department name and institution city. The institution postal code is optional.

If your manuscript proceeds to publication, affiliations will be published as they appear in your manuscript.

1. If the automatic affiliation selection is correct, click Yes, all affiliations are correct.
2. Alternatively, if the affiliation selection is not correct, click No, let me fix them.
a) Click and drag to highlight each affiliation in the manuscript.
If the affiliation selection is not correct, click Something is wrong with my affiliations and follow these steps.
3. Click Confirm affiliation(s).
4. If you do not want to specify affiliations for any of the authors of the manuscript, do the following:

a) Click Confirm no affiliation.
Research Exchange Submission displays the following prompt:

No affiliations found
If all authors are unaffiliated, check the box below.

b) Check the This manuscript has no affiliations box.

¢) Click Confirm no affiliation.

When you confirm that none of the authors of the manuscript has an affiliation, Research Exchange Submission
will do the following:

* In the next submission step, Author Details, the Affiliation(s) field for each author will be automatically filled
in with No Affiliation.

» Ifyou also do not specify any affiliations for any author in the next, Author Details, submission step, the
Match Organizations on page 37 submission step will be skipped for this submission, and will not be
included in the list of steps for this manuscript under My Submissions > Your Progress.

You will be redirected back to the Progress Board page for the submission. Under Your Progress, the next step you
need to take will be highlighted.

To continue your submission, click Author Details.

Something is wrong with my Affiliations

The affiliations in your manuscript have not been correctly selected.
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Why it happens

Research Exchange Submission is unable to correctly parse your main manuscript document, either due to special
formatting in the document such as word art, or for some other reason.

To resolve

1. Click Option 1: Edit and re-upload Main Document > Back to Upload Manuscript.
You will be redirected to the Upload Manuscript submission step, where you can delete your main manuscript
document and upload a new one.

2. Alternatively, click Option 2: Provide Affiliations manually in a later step > Provide Affiliations later.
You will be redirected to the Progress Board page for your submission, where you can choose to continue with the
next submission step, Author Details.

3. Or, if you want to try again to select affiliations from your manuscript, click Nevermind, I'll select Affiliations
from my Manuscript.
You will be redirected to the Affiliations submission step.
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Author Details

1. For each author name listed in the Author List section, do the following:

a) If the journal collects author honorific titles, you can specify the appropriate title for each author during initial
submission.

Author List

Marie Curie

Title Email

Prof. v mcurie@example.com

Prof. @

The titles collected are used when addressing authors in email notifications regarding the submission.

Note: Author honorific titles are collected only during initial submission. While you can update the author
titles during the revision stage in Research Exchange Submission, the updated titles will not be taken into
account in subsequent email notifications.

b) Ensure a valid email address is provided.
The email address cannot be longer than 128 characters.

¢) Choose a value from the Country/Location dropdown.

You cannot select more than one country/location for each author.
d) Ensure that the Primary Affiliation or Affiliation(s) ficld is not blank.

For conference submissions, select a single affiliation for each presenting author. No more than one affiliation
is allowed for each author.

For journal submissions, the Affiliation(s) field for each author is populated with the affiliations selected
during the Affiliations submission step.
If the author has no affiliation, select No Affiliation from the dropdown.

Alternatively, you can enter new affiliations or edit the existing ones in the Affiliation(s) field.
2. Select which author is the Corresponding Author.
You must select one corresponding author for the manuscript. You cannot select more than one.

3. If the journal collects author contributor roles using the CRediT taxonomy, the Author Details step will include
the Author Contributions (CRediT) section, and you can follow these steps to specify author contributor roles.
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4. If necessary, fill out the Submitting Agent section as follows:

a) If you are an author of the manuscript but your Research Exchange Submission account email address is
different than the email address you used in the manuscript, click I'm an Author of this manuscript and
select your name from the Author dropdown.

b) If you are not an author of the manuscript, click I'm not an Author of this manuscript and select your Role
from the dopdown.

If none of the values in the Role dropdown accurately describe your role, select Other... and enter your role in
the Role field.
5. If the journal collects ORCID information from submitting authors, the Author Details page includes the
Connect your ORCID iD section, and you can follow these steps to connect your ORCID iD to your Research
Exchange Submission account.

6. If you are submitting a revision or resubmission and the author list has changed since the initial submission,
provide an explanation for the change in the Authorship Changes > Explanation for authorship changes field.

Note: Reversing the order of an author's first and last names in the manuscript is considered a change to the
author list.

Once you submit a revision or resubmission that includes authorship changes, all the authors, past and present,
as well as the journal's editorial office, will receive an email notification with the authorship change and your
explanation for the change.

7. If you are submitting a conference paper, select the presenting author(s).

If the conference allows more than one presenting author, check the box next to each presenting author's name
under Presenting Author(s). If the conference allows only one presenting author, click the radio button under
Presenting Author.

a) For each presenting author, provide a biography that is no more than 50 words in the Biography field.
The biography is required.
8. Click Confirm.
If you cannot proceed because Research Exchange Submission displays the The following

affiliations have not been assigned to an author message, follow these steps.

If you cannot proceed because Research Exchange Submission displays the You must provide an
explanation for changes to the author 1list message, you must fill in the Explanation for
authorship changes ficld before you can proceed.

You will be redirected back to the Progress Board page for the submission. Under Your Progress, the next step you
need to take will be highlighted.

To continue with your submission, click Match Organizations.



Specify Contributor Roles Using the CRediT Taxonomy
1. Click Assign Roles.

Author Contributions (CRediT)

Assign Roles

U

The Author Contributions (CRediT) interface window will open.
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CRediT (Contributor Roles Taxon
outputs. Assigning roles credits e
article if the submission is accep

Learn more about Project CRedi’




| Start a New Submission | 34

2. Select one or more contributor roles for each author.
You must assign at least one role for each author.

Authors Roles

Marie Curie Conceptualization Methodology
Software Data curation

% Investigation Validation
Formal analysis Supervision
Funding acquisition Visualization
Project administration Resources
Writing - original draft Writing - review &
editing

The Role Summary section displays how many instances of each role have been assigned for all of the
manuscript's authors collectively.
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Role Summary

2/2 authors are assigned

Conceptualization
Software
Investigation

Formal analysis
Funding acquisition
Project administration

Writing - original draft

Methodology
Data curation
Validation
Supervision
Visualization
Resources

Writing - review &
editing

Confirm
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3. Once you have assigned the required roles, click Confirm to save the configuration and exit the interface.
The assigned roles will be displayed in the Author Details tab.

Roles Authors

Conceptualization -

Methodology Marie Curie

Software -

Data curation Pierre Curie
Investigation Marie Curie, Pierre Curie
Validation -

Formal analysis -

Supervision -

Funding acquisition

If you need to make edits, click Assign Roles to re-open the Author Contributions (CRediT) interface. Then, return
to the Author Details step to continue your submission.
The following affiliations have not been assigned to an author

Research Exchange Submission displays the The following affiliations have not been
assigned to an author message on the Author Details page, and you cannot proceed past this step.
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Author Details

Provide or confirm details for each author. Indicate which author is
the corresponding author for the purpose of editorial and peer
review. The editorial office will email each named author to confirm
participation.

Author List Something wrong? Edit authors or I
affiliations.

The following affiliations have not
been assigned to an author:

e Paris University

Why it happens

One or more affiliations in your manuscript that were identified during the Affiliations submission step have not been
assigned to an author during the Author Details step.

To resolve

1. Edit the Author Details > Author List > Affiliations field for each author to make sure that each affiliation in
your manuscript is associated with at least one author.
Once each affiliation is associated with at least one author, Research Exchange Submission will stop displaying
the relevant warning messages and you can complete the Author Details submission step.

2. Alternatively, if you want to edit your affiliations, return to the Affiliations submission step.

Editing your affiliations in Research Exchange Submission will not affect the affiliations as they will appear in
the published article. If you want to remove the affiliations from your manuscript altogether, return to the Upload
Manuscript step, delete your main manuscript file(s), and upload a version that includes only the affiliations you
want.

Match Organizations

This submission step is skipped if no affiliations are included in the manuscript main document, nor are any
affiliations specified for any author during the Author Details on page 31 submission step.

If this step is included, Research Exchange Submission will display a separate card for each affiliation.

Initially, each card is marked as Not Matched, which means you have not yet matched the institution name as you
have specified it in the manuscript main document or during a submission step with an institution name from the
database of institutions that Research Exchange Submission uses.
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X Mot Matched

University of Paris

The affiliation you provided ~ Choose best match

University of Paris THE AMERICAM UNIVERSITY OF PARIS
PARIS, ILE-DE-FRANCE, FRANCE

THE AMERICAMN UNIVERSITY OF PARIS LIBRARY
PARIS, ILE-DE-FRANCE, FRANCE

THE AMERICAN UNIVERSITY OF PARIS BOOKSTORE
PARIS, ILE-DE-FRANCE, FRANCE

OR

Search for best match

You only need to select your parent organization, you do not need to match your
department or other subdivision

Example- select University of Oxford, nor University of Oxford Departrment of
Economics

Find Organization

Research Exchange Submission will attempt to match each affiliation you provided during the Affiliations submission
step with an institution listed in the Ringgold database. During this step, you can confirm if the institutions identified
are correct, or, if necessary, manually associate institutions from the database with the affiliations you provided.

During this step, identifying your institution or organization is sufficient. It is not necessary to identify your specific
department.

Verifying your organizations during this step does not affect any information in your manuscript or published article.
The publisher will only use this information to identify any potential benefits you are eligible for based on your
affiliations, such as to help you publish open access and ensure compliance with open access policies.


https://www.copyright.com/solutions-ringgold/get-id/
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1. For each affiliation, do the following:

a) Select an option from the Choose best match section.
The card title for that institution changes to Matched.

¥  Matched
University of Paris
The affiliation you provided Choose best match

THE AMERICAN UNIVERSITY OF PARIS
PARIS, ILE-DE-FRANCE, FRANCE

University of Paris .

- THE AMERICAN UNIVERSITY OF PARIS LIBRARY
PARIS, ILE-DE-FRANCE, FRANCE

-, THE AMERICAN UNIVERSITY OF PARIS BOOKSTORE
PARIS, ILE-DE-FRANCE, FRANCE

oR

Search for best match

You only need to select your parent organization, you do not need to match your department or other
subdivision

Example: select University of Oxford not University of Oxford Department of Economics

Find Organization

Start typing to find your organization Q

b) Alternatively, if none of the options displayed in the Choose best match section are appropriate, type an
institution name in the Search for best match > Find Organization field and select an institution name from
the dropdown.

Search for best match

You only need to select your parent organization, you do not need to match your department or other
subdivision

Example: select University of Oxford, not University of Oxford Department of Economics

Find Organization

University of Paris| Q

THE AMERICAN UNIVERSITY OF PARIS BOOKSTORE
PARIS, ILE-DE-FRANCE, FRANCE

THE AMERICAN UNIVERSITY OF PARIS DEPARTMENT OF COMPARATIVE LITERATURE AND ENGLISH
PARIS, ILE-DE-FRANCE, FRANCE

UNIVERSITE PARIS-SACLAY POLYTECH PARIS-SARCLAY
ORSAY, TLE-DE-FRANCE, FRANCE

Can't find University of Paris? Organization is not listed

¢) If none of the institutions listed are appropriate, click Organization is not listed.
The dropdown of institution names is no longer displayed. Instead, the Search for best match section displays
Organization is not listed, and the affiliation card is marked Matched. Research Exchange Submission
records the affiliation to the institution name as you provided it.
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Search for best match

You only need to select your parent organization, you do not need to match your department or other
subdivision

Example: select University of Oxford, not University of Oxford Department of Economics

Organization is not listed %

d) If you want to add an affiliation, you will need to go back to the Upload Manuscript submission step, delete
your main document or title page file(s), upload a new version that includes the missing affiliation(s), and
repeat the submission steps after that.

2. Click Confirm.

You will be redirected back to the Progress Board page for the submission. Under Your Progress, the next step you
need to take will be highlighted.

To continue with your submission, click Additional Information.

Additional Information

1. Answer the questions asked during this submission step.

Ideally, you should answer all the questions. At a minimum, answer those that are required, otherwise you will not
be able to complete your submission.

2. Click Confirm.

If you encounter the Something went wrong error, follow these steps.

Why is it important to list my funders?

We ask you to select your funders from a list in order to help you comply with any funder publication mandates that
may apply to you. Often, this is related to selecting a specific license or copyright type, or related to publishing open
access.

What do | do if my funder is not listed?

We ask you to select your funder from a list in order to help you comply with any funder publication mandates that
may apply to you. You should type in keywords from your funder name in order to find it in the list. For example, you
could type Gates to quickly locate the Bill and Melinda Gates Foundation in the list.

If you are not able to find your funder in the list, type the complete funder name into the Select Funders ficld, then
choose Use [Your Funder Name]| as your funder from the dropdown. Please note that your publisher won’t be able
to help you comply with any relevant funder mandates if your funder is not selected from our list of known funders.

What is a data availability statement and why do | need one in my manuscript?

Some journals encourage data sharing wherever possible, unless this is prevented by ethical, privacy or confidentiality
matters. Authors may be expected to make their data, scripts, and other artefacts used to generate the analyses
presented in the paper available through a publicly available data repository. If the study includes original data, at
least one author must confirm that he or she had full access to all the data in the study, and takes responsibility for the
integrity of the data and the accuracy of the data analysis.

To enable readers to locate archived data, authors may be required to include a Data Accessibility section.
For more information and templates for the Data Availability statement, see the author guidelines for the journal.

If a data availability statement is not in your manuscript, you should add it and reupload your Main Document.
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What is a significance statement and why would | need one in my manuscript?

Your journal may require that your manuscript include a statement of significance or plain language summary for
certain article types.

If required, include your statement in the main text of the document. Typically these statements explain the
significance of the research paper written at a level that is understandable to the general public and to scientists
outside your field of specialty. Consult your journal’s author guidelines for specific requirements.

If the statement is required but is not in your manuscript, you should add it and reupload your Main Document.

How can | specify my preferred editors?

If the journal to which you are submitting is so configured, you can select your preferred editor(s) during the
Additional Information submission step.

Furthermore, specifying your preferred editors may be optional or required during initial submission and/or revision,
as is the number of editors you are allowed or required to specify.

If the question is optional, this will be displayed underneath the question title.

Preferred Select a preferred editor with expertise in
. your manuscript's specific subject matter
Editors Please note: the editorial office may

Optional choose different editors at their discretion

Preferred Editors

Marie Curie
Editor-in-Chief

Pierre Curie
Editor-in-Chief I
Humphry Davy

Editor-in-Chief

Alternatively, if the question is required, Research Exchange Submission will prompt you to fill in the required
minimum number of preferred editors before you can proceed to the Final Review submission step.

Preferred Select a preferred editor with expertise in l
. your manuscript's specific subject matter

Editors Please note: the editorial office may

choose different editors at their discretion

At least 1 editors are required.

Preferred Editors

To specify your preferred editors, click inside the search field. A list of the available editors will be displayed
underneath the field. The editors' names, roles and, where available, affiliations, are included in this list.

You can search for an editor by name, but not by role or affiliation.
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The details of the editors you select are added underneath the search field. If you the select the maximum allowed

number of editors, the search field is no longer displayed.

Preferred Select a preferred editor with expertise in

Editors

your manuscript's specific subject matter
Please note: the editorial office may

choose different editors at their discretion

Preferred Editors

Marie Curie
Editor-in-Chief b 4
Paris University

Possible Error Messages You May Encounter

If Research Exchange Submission is unable to retrieve the list of editors for the journal, it will display an error

message at the top of the Additional Information page. If the question is optional, you will be able to proceed with
your submission despite the error message. However, if the question is required, you will not be able to proceed with
your submission until the journal administrators resolve the issue.

The error message displayed differs for each case.

If the question is optional, the error message is: The list of available editors
retrieved. Please contact the editorial office at email@email

them of this error.

If the question is required, the error message is: The list of available editors
retrieved. Please contact the editorial office at email@email
them of this error, so you can complete your submission.

Final Review

could not be

.com to inform

could not be

.com to inform

The Final Review step allows you to confirm that all the information related to your submission is correct before you

submit your manuscript.

If you have questions regarding your submission that aren't answered here, on the Research Exchange Submission

help site, you can contact the journal's editorial office.

The information collected during the previous submission steps is presented on the Final Review page as follows:

Final Review Section

Submission Step During Which Information Was

Collected
Article Type Article Type
Peer Review Type Article Type
Note: If the journal does not allow submitters to select
the peer review type, this section is not included on the
Final Review page.
Title Title
Manuscript Files Upload Manuscript
Abstract Abstract
Authors

e Authors
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Final Review Section Submission Step During Which Information Was
Collected

¢ Author Details > Author List

Affiliations » Affiliations

* Match Organizations

Submitting Agent Author Details > Submitting Agent

Authorship Changes Author Details > Authorship Changes > Explanation
for authorship changes

Additional Information Additional Information

1. Review each section and, if necessary, click Edit to go to the corresponding submission step and make changes.

2. If the journal supports creating a reviewer PDF prior to submitting your manuscript, the Build Reviewer PDF
option will be available, and you can follow these steps to generate a reviewer PDF for your manuscript.

3. Once you are satisfied that everything is order in order, click Complete my submission.

If you are submitting a revision, click Complete my revision.

After you submit your manuscript, your work is sent to experts (peer reviewers) in your field of study in order to gain
their insight and suggestions. Reviewers will evaluate the originality and thoroughness of your work, and whether it
is a good fit for the journal you have submitted to. There are many forms of peer review, from traditional models like
single-anonymized and double-anonymized review to newer models, such as open and transferable review.

The length of the peer review process varies by journal, so check with the editors or the staff of the journal to which
you are submitting to for details of the process for that particular journal.

Once a manuscript is accepted, the article appears as Accepted on the My Submissions page, with the date it was
submitted and accepted.

Click View Accepted Submission Overview to view a summary of the submission.
it al Biciody ared [rusg Dt

TEST-Author Services revision cycle

I ssion SLatus y I

Click Show versions, to view the different available versions of the submission. You can also click Review decision
letter to open a read-only copy of the acceptance letter.
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Chamical Biology snd Drug Design

FRBGA TR ALTIACE (ARDELINEY  EWITHEAD TONTACT

Submission Overview

Accepted

Decision Letter
1 Review decision berter

History Accepted Or 13 October 2020 by Ecitonal Office

If your manuscript is not accepted and is not finally rejected, you can do one of the following:

» Ifarevision is required, submit a revision.
» If your manuscript has been returned (unsubmitted), resume its submission.
» If your manuscript has been rejected with the option to resubmit, resubmit it.

Create a Reviewer PDF
Note: The ability to create a reviewer PDF is not yet available for most journals.
EPS files are not included in the reviewer PDF.

Figure files larger than 10 MB are not included in the reviewer PDF.
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1. On the Final Review submission step, click Build Reviewer PDF.

Complete my submission

You're about to send your submission to the journal editors for review.
After you complete submission, you will not be able to make changes
unless your manuscript is returned by the editorial office.

Build Reviewer PDF

The Reviewer PDF combines your manuscript and submission files into
one file. This PDF is used by the editorial office and during peer review
to assess your submission. You have the option to view the Reviewer
PDF before it's sent to the editorial office, but it's not required to
complete submission. Building the Reviewer PDF can take up to 10
minutes, depending on the number and size of your files.

Build Reviewer PDF

Send submission

If everything looks correct above, click Complete my submission to
send it to editorial review.

Complete my submission +

Only files that are intended for peer review will be compiled into the reviewer PDF.
PDF generation can take several minutes, depending on the number and size of files in the submission. A spinner
is shown while the PDF is being compiled.

You are not required to build or view the reviewer PDF. You can complete your submission without creating or
downloading a Research Exchange Submission-generated reviewer PDF.
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2. Once the reviewer PDF has been generated, click Download Reviewer PDF to view the PDF.

Complete my submission

You're about to send your submission to the journal editors for
review. After you complete submission, you will not be able to make
changes unless your manuscript is returned by the editorial office.

Build Reviewer PDF

The Reviewer PDF combines your manuscript and submission files
into one file. This PDF is used by the editorial office and during peer
review to assess your submission. You have the option to view the
Reviewer PDF before it's sent to the editorial office, but it's not
required to complete submission. Building the Reviewer PDF can take
up to 10 minutes, depending on the number and size of your files.

Download Reviewer PDF

Is something wrong with your Reviewer PDF? You can edit or reorder
your files in the Upload step.

D Do not include the Reviewer PDF with my submission

Send submission

If everything looks correct above, click Complete my submission to
send it to editorial review.

Complete my submission +
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3. If you are not satisfied with the generated reviewer PDF, do one of the following:

a) Return to the Upload Manuscript step and make the required changes to your manuscript files, such as
reordering or replacing them.

You can repeat this process as many times as necessary.
Once you complete your changes, click Final Review > Build Reviewer PDF again to rebuild the PDF so that

it includes your latest changes before you submit your manuscript.
b) Click Do not include the Reviewer PDF with my submission to reject the reviewer PDF.

Download Reviewer PDF

Is something wrong with your Reviewer PDF? You can edit or reorder
your files in the Upload step.

% Do not include the Reviewer PDF with my submission

By not including a Reviewer PDF in your submission, the peer
review platform will generate a PDF instead, once your
submission has been completed. If you need to view the PDF file
you can contact the editorial office.

Let us know why you were not satisfied with the Reviewer
PDF. Your feedback will help us improve our system.

| do not want to include the Reviewer PDF with my
submission because...

429 characters remaining

You will be prompted to provide feedback regarding why you were not satisfied with the PDF. The Research
Exchange Submission-generated reviewer PDF will not be included in the package sent to the journal.
However, a PDF will still be generated by the peer review system.

If Research Exchange Submission fails to generate the reviewer PDF, follow these steps.

If Research Exchange Submission is able to successfully generate the reviewer PDF, after you submit your
manuscript, you can download the reviewer PDF from the manuscript's Submission Overview page.

You can download the reviewer PDF from this page even if you chose not to include it in the submission package.

A new reviewer PDF is generated at each submission or revision. You can download the PDF for each version of your
manuscript from Submission Overview > History.

Once you are satisfied that everything is in order with your manuscript, complete your submission.

The Reviewer PDF could not be generated

Why it happens
Reasons PDF generation might fail include:

» The PDF generation takes longer than 10 minutes, in which case the system will automatically time out and
display an error message.
* A manuscript file type is not supported or cannot compile successfully.
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To resolve

1. Click Try again to try to generate the PDF again.

2. Failing that, return to the Upload Manuscript on page 14 submission step and remove any image files that are
larger than 10 MB.

You can replace the removed image files with versions that are under 10 MB in size each.

3. Alternatively, click Complete my submission to submit your manuscript without creating a reviewer PDF on
Research Exchange Submission.
The manuscript's Submission Overview page displays the message: Reviewer PDF could not be
generated. However, if the platform supports it, a reviewer PDF will be created by the peer review system. You
can contact the journal's editorial office to request a copy of this PDF.

What should I do if something is wrong or missing within my manuscript?

Research Exchange Submission extracts important information from your main document to ensure that publication
metadata, such as title, abstract, author names, etc., match your manuscript exactly, and that required elements, such
as all author names, are present in your manuscript.

If a required element is not listed in your main document, follow the steps below to update your main document.

From the Progress Board, go to the Upload Manuscript step.

Locate and delete your main document.

Locate and open your local copy of the main document in MS Word.

Add or edit the missing or incorrect information and save your main document.
Drag the revised file into the Upload Manuscript step.

When the file upload is complete, select Main Document as the Type of File.

Click Confirm.

The system will reprocess your updated main document and attempt to automatically extract the missing or
changed information. You may be asked to return to a step to confirm that any changed information has been
correctly extracted.

A A

8. Once you are satisfied that all your submission details have been entered correctly, proceed to the Final Review
step and click Complete my submission to submit your manuscript.

Submit a Revision

If the journal requires that you revise your manuscript, the journal's editorial office will send you an email with their
decision letter.

Important: Do not submit revisions through a different application such as ScholarOne.

If you encounter difficulties while submitting your revision, contact Research Exchange Submission technical
support.

1. If the decision letter includes a link to Research Exchange Submission, do the following:

a) Click the link.
You will be redirected to Research Exchange Submission.
b) Login.
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2. Ifthe decision letter does not include such a link, do the following:
a) Navigate to Research Exchange Submission.
b) Login.
¢) On the My Submissions page, set Publication to the name of the journal and Submission Status to Open
Submission Statuses.

d) Locate the submission that requires a revision.
e) Click Revise Submission.
3. Click Upload Manuscript and follow these steps.

4. Alternatively, click Request an extension underneath the due date to request an extension.
Depending on how your device is configured, your email application, such as Gmail or Outlook, will launch so
that you can email the journal's editorial office and request an extension. Alternatively, your device will prompt
you to select which application should open the link.

5. Optionally, click Show versions to view the previous versions of this manuscript.

Resume Submission of a Returned (Unsubmitted)
Manuscript

If the journal has returned your manuscript to a draft state without issuing a decision on it, the journal's editorial office
will send you a relevant email.

Note: Editorial emails regarding returned/unsubmitted manuscripts are not available in Research Exchange
Submission.
1. If the email includes a link to Research Exchange Submission, do the following:
a) Click the link.
You will be redirected to Research Exchange Submission.
b) Login.
2. If the decision letter does not include such a link, do the following:
a) Navigate to Research Exchange Submission.
b) Login.
¢) On the My Submissions page, set Publication to the name of the journal and Submission Status to Open
Submission Statuses.

d) Locate the manuscript.

The manuscript will have the note, Returned to Draft.
e) Click Resume Submission.

Review the editorial office's email to you, and make the necessary changes to your initial submission.

Start Resubmission of a Rejected Manuscript

If the journal has rejected your manuscript but allows you to resubmit a new version of it, the journal's editorial office
will send you a relevant email with their decision letter.

1. If the decision letter includes a link to Research Exchange Submission, do the following:

a) Click the link.
You will be redirected to Research Exchange Submission.

b) Login.
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2. Ifthe decision letter does not include such a link, do the following:
a) Navigate to Research Exchange Submission.
b) Login.
¢) On the My Submissions page, set Publication to the name of the journal and Submission Status to Rejected.
d) Locate the manuscript that can be resubmitted.

3. Click Start resubmission.
The submission's status will be updated to Draft.
If you encounter the Your submission has been withdrawn error, follow these steps.

Specify your manuscript's Article Type.

Your submission has been withdrawn

Your submission has been
withdrawn

This submission cannot be edited any further.
Please see the latest email from the Editorial Office
for details.

A Back to My Submissions

Why it happens

You attempt to resubmit a previously rejected manuscript, but the submission has been withdrawn in the editorial
system,for example, ScholarOne.

To resolve

Coordinate with the journal's editorial office as to how you can resubmit.

For example, the editorial office may advise that you start a new submission in Research Exchange Submission, as
there is no further action you can take on a manuscript that has been withdrawn in the editorial system.

Import a Manuscript

About Email Notifications for Transferred Submissions

When an administrator for your destination journal initiates the transfer of your submission, you will receive an email
notification like the following, inviting you to complete the submission in Research Exchange Submission:
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Subject: Action Required: Finish your transferred submission to Title & Journa

1

Desktop Mobila 1 Plain Text
==

Hi UserFirstMame UserLastMName,
You recently requested we transfer your submission:

Longitudinal sequencing of TCR and circulating tumor DNA reveal
radiotherapeutic efficacy and pregnosis in nen-small cell lung cancer
patients with brain metastasis

Destination journal: Title & Journal
Destination reference code: 4fefd208-5c31-4f4f-3233-0cbZe7debtZa

Your previous manuscript files and details have all been transferred to your
selected journal - be sure to review your pending submission carefully.

To complete your transfer:

s Carefully review the destination journal's author guidelines and ensure
your submission meets the scope and reguirements.

s |fyou received feedback on your previous submission, consider revising
as appropriate

* | ogintothe Author Portal using the link below.

* Reaview your submission files and provide a revised manuscript, cover
letter, or accompanying files as neceszary.

*  Answer any newly required questions.

You will be asked to login or register for an account to use
this service.

Complete submission

Mote: This link is unigue to you. Please don't forward or share with
others.
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Completed peer review reports from your previous submission (if any) will be
shared with Title & Journal's editorial office,

Once submitted, you can track your manuscript’s status using the above link.
Meed more help?

s For questions regarding your transfer, contact Journal Contact.

s For support with your account or the Author Portal, contact
suppori@examplepublishing.com

o [fyou contact support, please include the destination journal
reference code: 4fefd808-5c31-474f-3233-0eb2e7deba2a,

By submitting a manuscript to or reviewing for this publication. your name, email address, and
affiliation, and other contact details the publication might require, will be used for the regular

operations of the publication, including, when necess sharing with the publisher and

partners for production and publication. The publication and the publisher recognize the

importance of protecting the personal information collected frem users in the operation of these

services and have practices in place to ensure that steps are taken to maintain the security,
integrity. and privacy of the personal data collected and processed. You can learn more by
reading our data protection policy. In case you don't want to be contacted by this publication

again, please send an email to Journal Contact.

Note: You will not receive a separate email with account details as you currently do in ScholarOne.

The email includes links to contact the journal editorial office with questions regarding your transfer and to contact
the publisher support team for technical support with your account or the Research Exchange Submission platform.

Once you click Complete submission in the email message, you will be prompted to log in to Research Exchange
Submission. If you do not already have a Research Exchange Submission account, you will be prompted to create
one.

Note: If you register for a Research Exchange Submission account using a different email address than the one you
used in your original submission, a two-factor authentication process is triggered where a verification code is sent to
the email address associated with the submission.
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Author Portal My Submissions w

Submission Import

Submission Information
Journal Testing Journal

Manuscript ID APTEST-2022-00081

Article Title Takk &hdidd dik didihdid dhdihdd dhddid didhdd Thdd dk ddd Fdddd Fh &k dddddddijnt

Send Code

Ta werify your ownership of this submission, we will send an authentication code to |Fwnymsedsssr com.
Yo will be asked to enter this code on the following screen.

Send Code -
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Hi:

Enter this venification code to confirm ownership of the submission and continue your transfer:

587239

iz attempting to transfer
Test Reject and resubmit without auther cheice This iz the Title of my Manuscript
From: Site for Portal Testing

To: Testing Journal

If yvou did not make this request, vou can ignore this message.
Need more help?

« For support with vour zccount or the Author Pertal, contact support@exameolepublishing.com

= For questions regarding vour transfer, contact the joumsl's editorial office

» If vou contact support, please include the destination journal reference code: 9ff14cef-201£-40c7-86a8-b328b32%a3d

Once you log in to Research Exchange Submission, you will be immediately directed to the Submission Progress
Board of your pending submission. The manuscript files, title, and abstract will be pre-populated using the values
from the previous submission and will be displayed in the Progress Board as checked, not locked. From the Progress
Board, you can proceed with completing your submission.

Reminder Notifications

If you do not complete the submission upon receiving the first notification, you will receive up to three subsequent
notifications according to the following schedule:

* Reminder 1: 5 days, 6 hours after the initial notification
* Reminder 2: 13 days, 12 hours after the first reminder
* Reminder 3: 25 days, 18 hours after the second reminder

Note: You cannot manage reminders. This means that you cannot put reminders on hold or decline offers. The draft
in Research Exchange Submission does not automatically expire if you do not complete it.

Complete a Transferred Submission

The process of transferring the submission must be initiated by an administrator of the journal to which you wish to
transfer the submission. If this has occurred, you will have received a relevant notification email.

This page describes how to complete a submission that was rejected by one journal and is in the process of being
transferred to another.
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1. Confirm the pre-populated data in the draft submission.

Research Exchange Submission will pre-populate the submission draft with all the data it can collect regarding

your previous, rejected, manuscript from ScholarOne.

a) Confirm the Article Type.

b) Confirm any journal-specific submission requirements.

¢) Confirm any additional information where prompted.
Steps where Research Exchange Submission is unable to automatically confirm the information without your
input are highlighted in red.

Note: You cannot skip ahead to a later step before confirming the information in the current step.
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Author Portal Return to Administrator view

Testing Journal

JOURMAL HOME AUTHOR GUIDELINES EDITORIAL CONTACT

A We made some changes

CQur submission process has been updated since your last visit and we need you to reconfirm some steps.

Criginal Article

TEST MANUSCRIPT--Papillary fibroelastoma of a mitral
valve chordae - case report

Submission Status Draft
Last Modified 1 February 2023 by Administrator
»  Showthis version history

Submission Started 31 January 2023 by System

Your previous ranuscript files have been transferred and your submission details have been entered.

To complete your transfer:

Specify your article type
2 Confirm your manuscript details and answer any newfy required guestions

You may exit at any time and your work will be preserved when you return. Your submission becomes
visible to the editorial office anly after you complete the last step.

Your P

Articdle

'  Abstrac

B Author
& Match
B Additio
& Final Re
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2. Ifnecessary, resolve any discrepancies between files you included in your original, rejected, submission and the
file types accepted by the journal to which you are transferring the submission.

If such discrepancies occur, the Review Transferred Files modal is displayed. Using this modal, you can do one

of the following:

* Click Delete all unmatched files to remove all files for which there is a discrepancy from your new
submission.

» Ifyou do not want to remove all unmatched files from your new submission, but instead want to remove only
specific files, click the trashcan icon for each unmatched file you want to remove.

* Select a new file type for an umatched file from the Destination file type dropdown.
* Click a file name to download the file.

a) Once you have completed your changes to unmatched files, click Confirm.

tal Imis

Review Transferred Files

Unmatched files @ Delete all unmatched files

These files could not be matched to a file type accepted by this journa

Joar
= Foreach file resolve the issue by selecting an appropriate file type or deleting the file
= You will have the opportunity to replace or add new files later
If you need help picking a file type, review the Auther Guidelines for more details on which files this
journal accepts
eq
nget
File name Issue Destination file type
icha SmeE. . -dock  File type unknown - i1
LIS ) ) ) ~
Matched files > Show 2 matched files
LSE i
Confirm
cript

Delete a Draft Transferred Submission

The process of transferring the submission must be initiated by an administrator of the journal to which you wish to
transfer the submission. If this has occurred, you will have received a relevant notification email.

Delete a draft transferred submission if you do not want to proceed with submitting your manuscript to the destination
journal.
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1. Log in to Research Exchange Submission.

2. Under My Submissions, locate the draft transferred submission you want to delete.
3. Click Delete.

Author Portal

Journal

My Submissions

All Journals -

Testing Journal

S } Delete
Original Article

Test Reject and resubmit without author choice This is the Title
of my Manuscript
Submission Status Draft

Manuscript [D APTEST-2022-00081

Last Modified 25 February 2023 by B
Resume Submission -
Submission Started 30 January 2023 by System

Complete a Publication Agreement

Note: Available only on platforms that support conference submissions.

Your conference submission has been accepted, but you need to complete the publication agreement.

1.

Click the link in the acceptance email you received.
You will navigate to Research Exchange Submission.

2. Log in to Research Exchange Submission if you are not logged in already.

3. Locate your conference submission, which will have a status of Accepted, Pending Agreement, and click Manage

Submission.

Click Publication Agreement.
You will navigate to the publication agreement system.

5. On the publication agreement system, accept the agreement.

6. Click Back to Submission Overview to return to your submission's page on Research Exchange Submission,

where its status is now updated to Accepted.
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Update an Accepted Submission

Note: Not applicable to all platforms.

If your manuscript has been accepted but the journal requires that you upload additional files, or make changes to
existing files, the journal's editorial office will send you an email with their required updates.
1. If the email includes a link to Research Exchange Submission, do the following:
a) Click the link.
You will be redirected to Research Exchange Submission.
b) Login.
2. If the email does not include such a link, do the following:
a) Navigate to Research Exchange Submission.
b) Login.
¢) On the My Submissions page, set Publication to the name of the journal and Submission Status to
Accepted, Updates Requested.

d) Locate the submission that requires updates.
e) Click Update submission.
3. Under Your manuscript has been accepted for publication, review the Screening Notes: section.
The updates requested by the journal's editorial office are listed under this section.
4. Click Upload Files.
Make the changes requested by the journal.

You can edit files under Editable Files. You cannot edit files under Locked Files, such as your main document
file.

a) To upload a new file, click Upload under the relevant section, for example, Figures and Tables.
b) To replace an existing file, click Update file.
c) To remove an existing file, click the delete icon.

5. Click Confirm.
6. Click Final Review.
Review the information on the Final Review page.
a) If everything is in order, click Complete my Update.
Alternatively, if you need to make additional changes, do the following:

a) Click Back to Progress Board.
b) Click Upload Files.

7. Optionally, click Show versions to view the previous versions of this manuscript.

Update a Conference Submission

Note: Applicable only to platforms that support conference submissions.

You can update a conference submission after you initially submit it as long as the conference's initial submission
deadline has not passed and the submission is in one of the following states:

e Submitted

1. Log in to Research Exchange Submission.
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2. On the My Submissions page, locate the conference submission you want to update.

If the submission can be updated, you will see the Manage submission button.

Otherwise, if the submission cannot be updated, for example, because the conference initial submission deadline
has passed, the Submission overview button is displayed instead.

3. Click Manage submission.
You will navigate to the Manage submission page for the conference submission.

4. Click Return to draft.
Your submission's state is updated to Draft.

From the My Submissions page, you can click Resume submission for this submission and make changes to any of
the submission steps you completed during initial submission such as Article Type on page 12.

To save your updates, you must complete the Final Review on page 42 step.

Withdraw a Manuscript

If the journal allows authors to withdraw manuscripts, contact the journal's editorial office and request that they
withdraw your manuscript.

Once your manuscript is withdrawn, it will reflect as such on your Research Exchange Submission dashboard.

- istor'y Withdrawn On 29 June 2021 by Editorial Office

You will not be able to take any further action on this submission in Research Exchange Submission.

Delete a Manuscript

In Research Exchange Submission, from your My Submissions page, you can only delete draft submissions, in other
words, manuscripts that you have not yet submitted.

1. To do so, first click the delete icon next to the manuscript title.

Lavoisier's Head
Research Article

Phlogiston and the Joy of Theoretical Chemistry @

Submission Status Draft @

Last Modified 19 December 2023 by Marie Curie
Resume Submission -
Submission Started 29 August 2023 by Marie Curie
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2. Click Yes, delete to confirm.
.

Are you sure?

’ No, cancel l

Yes, delete ®

3. Alternatively, if you want to delete a manuscript after you have submitted it through Research Exchange
Submission, contact the journal's editorial office. If deleting a submission is something the journal allows, it is
best to let the editorial office handle this.

Important: Do not delete submissions made through Research Exchange Submission in an editorial system such
as ScholarOne, as this will cause issues later in the submission process.

Resolve Failure for a Deleted Manuscript

When, on ScholarOne, you delete a manuscript that you submitted through Research Exchange Submission, then
Research Exchange Submission will send you an email notification that includes a link you can click to begin the
process of resending or resubmitting the manuscript.

If you did not intend to delete the manuscript, then follow the steps on this page. Alternatively, if you deliberately
deleted the manuscript, then you do not need to take any additional action.



| Delete a Manuscript | 62

1. Click Resolve failure in the email you received about the deleted manuscript.

Deletion confirmation for "Phlogiston
and the Joy of Theoretical Chemistry"

Lavoisier's Head

tome

Hi Marie Curie,
The following submission has been deleted:

Submission title: Phlogiston and the Joy of Theoretical Chemistry

Journal: Lavoisier's Head

If this removal was an error and you still want the submission to be
considered for publication as itis, resolve the failure by resending it to the
journal or resuming submission to make changes.

Resolve failure

Sincerely,

The Editonal Office at Lavoisier's Head

Alternatively, without clicking the link in the email, you can log in to Research Exchange Submission. The options
to resend or resubmit will be displayed on your My Submissions page as well as on the Submission Overview
page for the deleted manuscript.

Note: This email is sent only to the person who submitted the manuscript through Research Exchange
Submission, and not, for example, the manuscript's co-authors. However, a Submission failed warning is
displayed in Research Exchange Submission for co-authors on their My Submissions page and the Submission
Overview page for the manuscript until the failure is resolved.

Clicking the link will open the Research Exchange Submission Submission Overview page for the manuscript.
If you were not already logged in to Research Exchange Submission before clicking the link, Research Exchange
Submission will prompt you to log in.

2. On the Submission Overview page for the manuscript, do one of the following:

A Submission failed

This submission was removed
from consideration. Resend to journal -

publication as it is, resend your
submission. Otherwise, resume
submission to make changes.

Resume submission -

lfyou el _

a) To resend the submission to the journal as it is, without making any changes, click Resend to journal.
b) To make changes to the submission, click Resume submission.
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Click on an error message below to see how to resolve it.

Something went wrong on page 63

We cannot accept file names larger than 256 bytes on page 23
No .tex files found on page 20

A virus has been found: Remove or replace this file on page 23
Title exceeds journal's limit on page 25

Abstract exceeds journal's limit on page 27

The following affiliations have not been assigned to an author on page 36
The Reviewer PDF could not be generated on page 47

Your submission has been withdrawn on page 50

Resolve Failure for a Deleted Manuscript on page 61

You must provide an explanation for changes to the author list
Unexpected error when authenticating with identity provider

Something went wrong

Research Exchange Submission may display the Something went wrong error for several reasons.

Something went wrong

Qur team has been notified. Please check back
later.

A Retry

Cause 1: Same file used for both the main document and title page

For a submission that will be reviewed using double anonymized peer review, you have uploaded the same file for
both the main document and title page, and Research Exchange Submission displays this error during the Authors on
page 28 submission step.

To resolve

1.
2.
3.

Return to the Upload Manuscript on page 14 submission step.
Delete the main document and title page files.

Upload a new version of each file.

Ensure that author-identifying information is included only in the title page and not the main document.
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Cause 2: Selected keywords or research topics are too long

When answering the Keywords or Research Topics question during the Additional Information on page 40
submission step, one or more of the keywords or research topics you entered or selected from a dropdown may be too
long.

To resolve

1. Select keywords or categories that are shorter in length.

2. Alternatively, if the question is not required to proceed with the submission and you are comfortable not providing
keywords for the manuscript, you can choose to not answer this question.

Other Causes

In some cases, it may be unclear why Research Exchange Submission displays the Something went wrong
error. The root cause of the issue may be something unrelated to your submission, such as a temporary connection
disruption.

To resolve

1. Reload the page.
2. If that does not work, retry after a few minutes.
3. Ifthe issue still persists, try the following:
a) Log out of Research Exchange Submission.
b) Navigate to the journal's submission page.
c¢) Click Submit or similarly labeled link on the submission page, to return to Research Exchange Submission.

The objective is to navigate to a page with a URL such as https://{publisher
code}.atyponrex.com/journal/{journal code}, where { journal code} is the journal's
code. For example, a journal titled Lavoisier's Head may have the journal code LVH, in which case the
relevant URL will be https://{publisher code}.atyponrex.com/journal/lvh.

d) Log back in to Research Exchange Submission.
4. If performing the above steps does not resolve the issue, create a new submission.
5. If all of the above fail to resolve the issue, contact Research Exchange Submission support.

Unexpected error when authenticating with identity provider

When this error occurs, the message is displayed after you log in.

Atypon REX | Submission My Submissions | Login or Register

Unexpected error when authenticating with identity provider

To resolve

In your browser, manually go to https://{publisher code}.atyponrex.com/submission
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